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[bookmark: _Toc5889359][bookmark: _Toc6216655][bookmark: _Toc6925619][bookmark: _Toc6926611][bookmark: _Toc7602418][bookmark: _Toc7679179][bookmark: _Toc8110270][bookmark: _Toc8374038][bookmark: _Toc8374122][bookmark: _Toc8374251][bookmark: _Toc8374496][bookmark: _Toc8374751][bookmark: _Toc8375393][bookmark: _Toc9848118]Writing Learning Materials
[bookmark: _Toc5889361][bookmark: _Toc6216656]This Writing Learning Materials document is developed as a guide for the Learning Team for writing all learning materials, such as the Workbooks, Help Topics and Key Learning Reviews. The first 5 pages summarize the key points to get you started on writing with a template and adding tables and screenshots appropriately. Following the summary is an extensive manual with grammar examples, detailed step by step guide to apply and adjust different types of formatting, as well as on capturing the best screenshots. 
[bookmark: _Toc6925620][bookmark: _Toc6926612][bookmark: _Toc7602419][bookmark: _Toc7679180][bookmark: _Toc8110271][bookmark: _Toc8374039][bookmark: _Toc8374123][bookmark: _Toc8374252][bookmark: _Toc8374497][bookmark: _Toc8374752][bookmark: _Toc8375394][bookmark: _Toc9848119]Quick References
Refer to the Learning Team Style Guide and the CST Cerner Help Glossary for spelling and use of common terminology.
Remember your audience is a diverse group of healthcare professionals who may not be familiar with Cerner terms.
Use the appropriate template for each type of learning material. Templates are found on Confluence.
Each template will have pre-set Styles created for learning.
When copying from another document and pasting, 
Copy the text, 
Format the paragraph where you want to paste the content.
Right-click where you want to paste the copied content. 
Always choose Keep Text Only in the Paste Option to avoid altering and adding unnecessary styles (found on page 16).
[image: ] 
Use present tense and active voice as much as possible.
Use concise plain language.
Use bold to emphasize the part of the screen you are taking action on. (eg. Review Patient List, Click OK button, etc.)
Use bold and italic for entries learner is required to enter into the system. (eg. Type 38.4)
Use underline only for hyperlink.
Use Snagit to annotate images. Also see page 32. 
Use red circle with number to identify step by step in a screenshot. [image: ]
You can use lowercase letters for substeps. [image: ]
Use red square with alphabet to identify parts of the screen in a legend. [image: ]
[bookmark: _Toc5889362][bookmark: _Toc6216657][bookmark: _Toc6925621][bookmark: _Toc6926613][bookmark: _Toc7602420][bookmark: _Toc7679181][bookmark: _Toc8110272][bookmark: _Toc8374040][bookmark: _Toc8374124][bookmark: _Toc8374253][bookmark: _Toc8374498][bookmark: _Toc8374753][bookmark: _Toc8375395][bookmark: _Toc9848120]Grammar Tips
Further detailed examples and tips are found on page 8
· Instructing the learner to click somewhere e.g. the <name> button or the <name> tab. 
· Prepositions are usually used in front of nouns or pronouns and they show the relationship between the noun or pronoun and other words in a sentence. 
· Incorrect preposition up e.g. when to use “in”, “on”, “at”, and “over”. 
· Although it is not grammatically wrong to end a sentence with a preposition, it is less formal. Be sure that the meaning of the preposition is clear.
· When using pronouns, make sure it is clear as to which noun the pronoun is representing. Define what it is in a sentence when there is more than one noun (the antecedent). 
[bookmark: _Toc5889363][bookmark: _Toc6216658][bookmark: _Toc6925622][bookmark: _Toc6926614][bookmark: _Toc7602421][bookmark: _Toc7679182][bookmark: _Toc8110273][bookmark: _Toc8374041][bookmark: _Toc8374125][bookmark: _Toc8374254][bookmark: _Toc8374499][bookmark: _Toc8374754][bookmark: _Toc8375396][bookmark: _Toc9848121]Create Learning Document
Find and download the appropriate template from Confluence.
Open the template document.
Save the document as a word document in accordance to the naming convention.
Refer to Master Tracker file under 13.0 in Confluence: https://wiki.phsa.ca/pages/viewpage.action?spaceKey=LEAR&title=13.0+Classroom+Materials
As you write your document, ensure that you apply the appropriate preset styles as needed.
Refer to the Template Assistance document if unsure which style to use.
If applicable, update your Table of Contents (TOC). Found on page 21.
[bookmark: _Toc5889364][bookmark: _Toc6216659][bookmark: _Toc6925623][bookmark: _Toc6926615][bookmark: _Toc7602422][bookmark: _Toc7679183][bookmark: _Toc8110274][bookmark: _Toc8374042][bookmark: _Toc8374126][bookmark: _Toc8374255][bookmark: _Toc8374500][bookmark: _Toc8374755][bookmark: _Toc8375397][bookmark: _Toc9848122]Upload Your Document
The following process is only applicable to printed learning materials. The process allows differentiation on the status to your learning materials: Draft, Active and Archive. You will only be uploading to draft sections. Each learning material document should have multiple versions originated from the same draft file. To finalize a draft and put forward to printing, review the completion checklist found in the Template Assistant document. For full details on how to move your learning materials to active status for print, please follow instructions on Confluence:
https://wiki.phsa.ca/display/LEAR/13.0+Classroom+Materials?preview=/49663242/57900470/Curriculum%20and%20Confluence%20Clean%20Up.pptx

Follow the steps below to upload to the draft sections of various printed learning material:
1. Open Confluence page under Learning 13.2, 13.5 or 13.8 to access draft areas.
To upload an updated version of the current draft that is already in the designated section. Lock the draft. Make sure your document name matches the current draft. Drag the new version on top of the previous version. Unlock the draft.
If this is the first time you are uploading the learning material, ensure it is named in accordance to the naming convention.
Upload your file
[image: ]
A new version of your file will be placed in the designated area.
[bookmark: _Toc5889370][bookmark: _Toc6216662][bookmark: _Toc6925624][bookmark: _Toc6926616][bookmark: _Toc7602423][bookmark: _Toc7679184][bookmark: _Toc8110275][bookmark: _Toc8374043][bookmark: _Toc8374127][bookmark: _Toc8374256][bookmark: _Toc8374501][bookmark: _Toc8374756][bookmark: _Toc8375398][bookmark: _Toc9848123]Learning Material Styles
[bookmark: _Toc6925625][bookmark: _Toc6926617][bookmark: _Toc7602424][bookmark: _Toc7679185][bookmark: _Toc8110276][bookmark: _Toc8374044][bookmark: _Toc8374128][bookmark: _Toc8374257][bookmark: _Toc8374502][bookmark: _Toc8374757][bookmark: _Toc8375399][bookmark: _Toc9848124]What are Word Styles?
In Microsoft Word, styles are a collection of pre-set formatting options for the layout of different elements in the document. Applying a style is quick and helps you use consistent formatting throughout your document. 
[bookmark: _Toc6925626][bookmark: _Toc6926618][bookmark: _Toc7602425][bookmark: _Toc7679186][bookmark: _Toc8110277][bookmark: _Toc8374045][bookmark: _Toc8374129][bookmark: _Toc8374258][bookmark: _Toc8374503][bookmark: _Toc8374758][bookmark: _Toc8375400][bookmark: _Toc9848125]Styles Overview
	Type
	Styles
	Details

	Basic Text
	BodyText
TableText 
Table Heading

	For use in all general paragraphs

	Basic Headings
	Workbook Title
Heading 1
Heading 2
Heading 3
Heading 4
	Heading 1,2 and 3 are used in Help Topics

	Special Bullet Headings
	TOC Title
Activity
Scenario
Proficiency
Introduction
View Only
	Have icons in front and used as a heading to a section

Activity and Scenario style have pagination settings attached

	Special Bullet (non Headings)
	Key Learning
	Have icons in front but not a heading style

	Character (Font)
	Last_Updated
	Applied to selected text

	List
	BodyBullet1
BodyBullet2
BodyBullet3
Step1Number
Step2Letter
Step2Bullet
Step3Bullet
Step4Bullet
Bullet Green
LegendLetter
	The numbering in the list styles identify the level/ amount of indentation.
Bullet Green is a list style with a green icon in front, generally used in listing with a table.
Body_Bullet Styles are use for teaching points, outside of step by step instructions.
Step Styles are used for step by step instructions.
Legend Letter is an alphabetical order listing system specific for use on View Only section.


[bookmark: _Toc9848126][bookmark: _Toc5889373][bookmark: _Toc6216665][bookmark: _Toc6925627][bookmark: _Toc6926619][bookmark: _Toc7602426][bookmark: _Toc7679187][bookmark: _Toc8110278][bookmark: _Toc8374046][bookmark: _Toc8374130][bookmark: _Toc8374259][bookmark: _Toc8374504][bookmark: _Toc8374759][bookmark: _Toc8375401]Preparing Your Screen
To start creating your document, it will be helpful for you to display tools in Word that will assist you to apply styles and formatting. 
[bookmark: _Toc9848127]Show Navigation Pane
1. Under the View tab, ensure Print Layout is selected and check Navigation Pane.
[image: ]

[image: ]
[bookmark: _Toc9848128]Show Style Pane
1. Open the Style Pane using the Launcher icon under the Styles group on the Home tab.
Each template has formatting and standardized Styles built in. By having the Style Pane expanded, you can quickly access the list of the styles and apply to sections of the document.
[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML711843.PNG]
1. To preview what a Style looks like, place your cursor on the text and hover over the different styles.
[image: ]
1. You can click on the More button to expand see how the styles
[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML633fe99.PNG][image: ]
	[image: ]
	NOTE: Do NOT Modify any of the features of the Styles. These styles will make your work easier and serve to maintain a consistent look for all workbooks.



[bookmark: _Toc9848129]Show Non-Printing Characters
1. Show Non-Printing Characters to help you understand the types of breaks you have used in between words and lines.
[image: ]


Popular Non Printing Characters:
	Types
	Looks Like

	Paragraph Marker
	[image: ]

	Line Break
	[image: ]

	Tab
	

	Space (between words)
	[image: ]



[image: ]
[bookmark: _Toc6925628][bookmark: _Toc6926620][bookmark: _Toc7602427][bookmark: _Toc7679188][bookmark: _Toc8110279][bookmark: _Toc8374047][bookmark: _Toc8374131][bookmark: _Toc8374260][bookmark: _Toc8374505][bookmark: _Toc8374760][bookmark: _Toc8375402][bookmark: _Toc9848130]General Formatting
· DO NOT use Bullets, Numbering, Multilevel List, Decrease Indent, or Increase Indent buttons within the Paragraph settings on your home tab. Always apply the style paragraph by paragraph by clicking the style name in the list.
· Press SHIFT+ENTER keys twice to start a new line under the same style to ensure indentation is aligned for screenshots or additional text. Detail information found on p. 16. 
· Avoid using Ctrl-Enter to start a new page to avoid awkward page breaks. Major styles have pagination settings. See controlling page breaks on page 16.
· If you are copying and pasting, please paste the text only. Then, apply the style with the list.
For specific formatting application, please find full step by step in manual attached:

	Formatting
	Page

	Font
	9

	Paragraph
	11

	Bullet and Numbering List
	12

	Section
	13

	Page Break
	11

	Table
	16


[bookmark: _Toc6925629][bookmark: _Toc6926621][bookmark: _Toc7602428][bookmark: _Toc7679189][bookmark: _Toc8110280][bookmark: _Toc8374048][bookmark: _Toc8374132][bookmark: _Toc8374261][bookmark: _Toc8374506][bookmark: _Toc8374761][bookmark: _Toc8375403]
[bookmark: _Toc9848131]Capturing screenshots
For full details with screenshot guidance, go to page24 
· Use Snagit to capture your screenshot.
· Perform screenshot adjustments (e.g. cropping) in Snagit not in Word document.
· Use the shape drawing tools in Snagit to highlight the area you are showing.
· Use the default red circle (found in the Snagit Tools tab) for any areas that need to be called out sequentially. Don’t add the red circle with number in Word document. Add in Snagit and then copy-paste the whole image to the Word document. Align the numbering on the screenshot with written instruction explained in content. Use small lower case letters if necessary to convey sub-steps. 
· For identifying areas of the legend, use the square style, change the fill to red and double click on the number to change to upper case alphabets. 











[bookmark: _Toc7602429][bookmark: _Toc7679190][bookmark: _Toc8110282][bookmark: _Toc8374049][bookmark: _Toc8374133][bookmark: _Toc8374262][bookmark: _Toc8374507][bookmark: _Toc8374762][bookmark: _Toc8375404][bookmark: _Toc9848132]Writing Learning Materials Manual

[bookmark: _Toc6925631][bookmark: _Toc7602430][bookmark: _Toc7679191][bookmark: _Toc8110283][bookmark: _Toc8374050][bookmark: _Toc8374134][bookmark: _Toc8374263][bookmark: _Toc8374508][bookmark: _Toc8374763][bookmark: _Toc8375405][bookmark: _Toc9848133]Table of Content
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[bookmark: _Ref7157268][bookmark: _Toc9848134]Grammar Examples
	Word
	Grammar
	When it’s used
	Incorrect

	The
	definite article
	Use “the” where you referring to a specific noun.
The determiner “the” is also known as an article. Articles are words that define a noun as specific/definite (“the”) or unspecific/indefinite (“a”, “an”).
Click the <name> button, icon, link
Click the <name> tab
	“On the” is not as concise

	On
	preposition
	A preposition to refer to a position on any surface (computer screen). For pages, including online pages, always use ON.
Click the Add button on the Orders page.
	In

	In
	preposition
	A preposition of place used to discuss an enclosed space. Used to indicate a specific location within a larger area
Click in the Search box and type...
Click the Heading in the Results component.
Click the Ok button in the Confirmation window.
Click Refresh in the top right corner
	

	At
	preposition
	Click the Sign button at the bottom of the page
	

	Over
	preposition
	Use over when something is covering something.
Hover your mouse over
	

	It, Them, He, She, You, Their, Her, Him, Its, This, That, Who, Which and more 
	Pronouns and their antecedent
	There are many different pronouns, and different types of pronouns.
A pronoun represents a noun. In grammar, the meaning of the pronoun is dependent on an antecedent (or noun) it represents. 
When using pronouns make sure the pronoun is clear. “It”, “his”, “her”, “them”, “their” pronouns need to have the noun, the pronoun is representing, defined.  When there is more than one noun using a pronoun could be ambiguous. 
Paul brings his dog Rex to visit patients. Rex loves to give sloppy wet kisses to the patients.
	Paul brings his dog Rex to visit patients. He loves to give sloppy wet kisses to the patients.


[bookmark: _Toc6216673][bookmark: _Ref6907941][bookmark: _Toc9848135]Copy and Paste 
If you are copying and pasting from another document, it is recommended that you copy and paste sections by sections. 
	[image: ]
	WARNING: You MUST paste the content as Text only to prevent copying the styles from the other document.



[bookmark: _Toc9848136]Copy and Paste Text from another Document
When you copy from one document and paste the content to another document: 
1. Select text you want to copy and press Cltr + C or right click to select Copy.
[image: ]
1. Go to the document you want to paste into. Move your cursor to where you want to paste the content. Before you paste the text apply the formatting you want the pasted text to have.
1. Right click to select Keep Text Only in the Paste Options popup menu.
[image: cid:image001.png@01D4FE7E.BE0833D0]
1. Apply the appropriate template styles using the Style Pane to the pasted text as required.
[bookmark: _Toc6216675][bookmark: _Ref7598823][bookmark: _Toc9848137]Copy Tables
[bookmark: _Toc9848138]Copy and Paste a Table from another Document 
1. Copy the table from the applicable template or create a new table in the new document. 
1. Select the text in the table that you want to copy.
1. Format the paragraph in the new location.
1. to select Keep Text Only in the Paste Options popup menu.
[image: cid:image001.png@01D4FE7E.BE0833D0]
1. Apply the appropriate template styles using the Style Pane to the pasted text as required.
[bookmark: _Toc9848139]Copy or Move a Table from your Current Document
14. Hold your mouse point near the beginning of a table. 

You will see the Table Handle [image: ]. 
Click the Table Handle to select entire table.
[image: ]
Click Cut to move the table or Copy. 
Move you cursor to the new location. You might need to add a new paragraph.
Click Paste. [image: ]
[bookmark: _Toc5889372][bookmark: _Toc6216664][bookmark: _Toc9848140]Formatting and Styles
Word uses different kinds of formatting settings. This section will focus on the formatting required when writing Learning Materials. Most of the font and paragraph formatting is part of the styles you will use. 
[bookmark: _Toc9848141][bookmark: _Toc5889374][bookmark: _Toc6216666]Appropriate use of Character Formatting
In all Learning Materials, the font should be Arial to adhere to the CST Branding guidelines. You should not need to change the text except to bold or italicize specific words, according to the Style Guide.
Use bold to emphasize the part of the screen (e.g., name of an application, button, window, or PowerPlan). 
Use bold to emphasize a word, such as “not”
Use bold and italics to indicate the exact information a learner needs to type into the system, 
e.g. Type 38.4
Only use underline for hyperlinks as most identify underlined text as a link and not as part of text that require audience to pay special attention to. 
[bookmark: _Toc9848142][bookmark: _Toc5889376][bookmark: _Toc6216669][bookmark: _Ref6915622]Font Formatting
Character or font formatting is applied on a word by word basis. 
Use the Font group on the Home tab for general formatting such as Bold, Italics and Underline.
[image: ]

Click the Launcher icon for full options on font style.
[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML53cd5b1.PNG]
[bookmark: _Toc6216667][bookmark: _Ref6915600][bookmark: _Ref7178920]Applying Font Styles
Font styles display an a [image: ] on the right side of the style listed in the style panel.
To apply a Font Style, e.g. Last Updated [image: ]: 
Select the words only, not any spaces or paragraph markers after the text. 
Select the style from the Style Pane. 
[bookmark: _Toc5889375][bookmark: _Toc6216668][bookmark: _Ref6915619][bookmark: _Toc9848143][bookmark: _Ref9578134][bookmark: _Ref9578141]Paragraph Formatting and Styles
Some styles have both paragraph and font formatting. Most heading styles fall into this category since the font size is often larger and the heading could be bold or italic and even a different colour. There is also paragraph formatting, such as the alignment and before and after spacing for the heading. Paragraph styles display a paragraph marker [image: ] beside the style name in the Style Pane Paragraph and font styles display both a paragraph marker and an a [image: ].
[bookmark: _Toc9848144]Paragraph Formatting 
DO NOT use Decrease Indent or Increase Indent buttons within the Paragraph settings default on your Home ribbon. 
[image: ]
There are a number of paragraph settings that can be applied to a single paragraph or a number of selected paragraphs. 
Click the Launcher icon to set a number of settings in the Paragraph dialog box.
 [image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML542b7a6.PNG]

[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML1f8c635.PNG]
The paragraph settings in the screen shot above are for a bulleted or numbered list. It includes the following settings:
	LEGEND

	A
	The General Alignment is Left aligned.

	B
	Indentation Left: The entire paragraph is indented .63cm

	C
	Special Indentation: Hanging By .63cm. This means that although the first line of the paragraph is indented by .63cm, the other lines of the paragraph are indented an additional .63cm. 

	D
	Spacing Before and After:  Before the current paragraph there is no additional spacing, or buffer space. After the current paragraph there is 12pt spacing. That is like a blank line of buffer space between the current paragraph and the next paragraph.

	E
	Line Spacing: Is set to Multiple Line spacing of 1.15. This is the spacing between each line in a paragraph. Single line spacing is 1, so 1.15 spacing is a little more spacing that single line spacing. Other examples of Line Spacing include Double spacing.


Applying Paragraph Styles
Paragraph styles display a paragraph marker [image: ] beside the style name in the Style Pane.
For Paragraph Styles [image: ]
1. Place the cursor somewhere on the line/paragraph.
Click the style name from the Style Pane.
You can use the paragraph styles on the Quick Styles. 
[image: ]
Applying Paragraph and Font Style
For Paragraph and Font Styles [image: ], 
That means you need to select multiple words to apply the settings to more than one word. When applying the setting to one word, you only need to have your cursor in the word.
Heading Styles are an exception to this rule. You only need to click anywhere on the line (paragraph) and click the applicable heading style.
[bookmark: _Toc9848145]Headings and Sub-Headings 
Heading and sub heading styles contain paragraph and font (size) formatting.
Only use the heading styles indicated in the template.
Capitalize all “major” words (nouns, verbs, adjectives, adverbs, and pronouns) in the title/heading, including the second part of hyphenated major words (e.g., Self-Report not Self-report); 
Use lowercase only for “minor” words of three letters or fewer
Some heading styles are based on Word Heading style and include a Level number. By default heading with a level number of 1 to 3 are pulled into a Table of Contents.
Some heading styles include a graphical bullet with a hanging indent (Special Bullet Headings). 
Most heading styles include Before and After Spacing 
Heading styles usually also have some Pagination settings that will keep the heading with the next paragraph. This means that if the Heading is near the bottom of a page the page will break to make sure the heading stays on the same page as the first line or two of the following paragraph. 
Some heading styles will have a Page break before the Heading (e.g. Scenario and Activity).
[bookmark: _Toc9848146]Table Heading Style
Table Heading style uses bold and a small left indent. See example below:
[image: ]
It does not have Pagination settings.
[bookmark: _Toc9848147]Key Learning Style
Key Learnings style uses font formatting (font size and bold) as well as paragraph formatting (left indent, before and after spacing). See example below:
[image: ]
[bookmark: _Toc5889377][bookmark: _Toc6216670][bookmark: _Ref6915624][bookmark: _Toc9848148]Bullet and Numbering Lists Styles
Bullets and numbering lists use specific paragraph formatting. It comprises of a number, letter or bullet, followed by a tab. There is a hanging indent which indents the second and subsequent lines in the paragraph to line up with the text in the first row. 
DO NOT use Bullets, Numbering, Multilevel List within the Paragraph settings default on your Home ribbon. 
[image: ]
1. Place the cursor somewhere on the line/paragraph.
Click the style name from the Style Pane.
You can use the BodyBullet or Step styles on the Quick Styles. 
[image: ]
Always apply the style paragraph by paragraph by clicking the style name in the list.
Body Bullet Lists
BodyBullet1 - use when covering teaching points that do not involve step by step instructions
There maybe three levels to this list (Body-Bullet-1, Body-Bullet-1, Body-Bullet-2 and Body-Bullet-3)
BodyBullet2: Each level of the multilevel list indents nicely under the previous level
BodyBullet3: Indents under BodyBullet2. 
When there are more than one list item that uses the same list style (for BodyBullet 3) there is no additional spacing between the list items.
Step by Step Lists
1. Step1Number – use for each consecutive step. It is automatically numbered.
Step2Bullet– use for different options within the numbered step when order is not important (indents under Step 1 Number)
Step3Bullet – use for sub steps when order is not important (indents under Step 2 Bullet or Step 2 Letter)
Step1Number – use for each consecutive step. It is automatically numbered.
a. Step2Letter – use for sub steps when order is important (indents under Step-1-Number)
b. Step2Letter
Step3Bullet – use for sub steps when order is not important (indents under Step-2-Bullet or Step-2-Letter)
Restart and Continue Numbering
When stating a new list, the new list will either continue the numbering from the previous list or the numbering will continue from the previous list.  You can control how you want the numbering to work.
1. Remember to use the appropriate Step style.
.Right-click on the number. [image: ] A list of options will appear.
Choose to Restart at 1, when the numbering has continued but you want a new numbering list. 
Choose to Continue Numbering, when the numbering has restarted at 1 but you want the numbering to continue from the previous list.
[image: ]
[bookmark: _Toc9848149]Step by Step Instructions
When creating step by step instructions:
· Each action should be a separate step (number). This will help ensure the learner does not miss a step.
· Start with the action word to help the learner know what the step involves. 
· Bold the part of the screen they will act on. This helps them locate and learn the part of the screen.
· The numbers in the image need to correspond with the numbers in the step by step instructions.
· Use Snagit to add numbers (or letters), boxes and arrows as needed. For more information about images see page 39

[image: ]Numbers are added in Snagit. Numbers always need to match the numbered instruction.
The result of the step is NOT another step. It should not be numbered. IT is also lined up with the text in step 3.

Results Text
In the example above, the result of completing steps 3 is that the Order Information window opens. 
· The result of an action can include an image, text or both. 
· The result sentence should be part of step 3, NOT the beginning of step 4. Here we see it in on a separate line. Once again, this helps to prevent the learner from missing a step that is buried in a paragraph. 
Lists Combining Step1Number with Step2Bullet 
In this example the sub steps are listed with bullets. Step2 indicates the sub steps are indented under the numbered items (Step1). 
Using this combination can 
· Help the learner to identify the main steps
· Each sub step can typically be done in any order
· If you add a screen shot you would not be able to annotate the bulleted list but as we see here, the image that follows, displays the results.
Example:
[image: ]
Combining Steps with Ordered Sub Steps
In this example the sub steps are listed with a lowercase letters. Step2 indicates the sub steps are indented under the numbered items (Step1). 
Using this combination can 
· help the learner to identify the main steps
· list the sub steps in a particular order
· An image can be annotated with the lowercase letters in red circles, to identify where the learner needs to click for a given set of sub steps.
Example:
[image: ]
[bookmark: _Ref9506342]Lists and Annotated Screenshots
· Use red circles with numbers to annotate the image. Be sure to do this in Snagit, not Word.
· The numbered steps should align with the numbers in the red circles.
· Be sure not to put too many steps on one screenshot as it could be hard to read. In this example there are two screen shots of different screens.
Example:
[image: ]

[bookmark: _Toc9848150][bookmark: _Toc5889379][bookmark: _Toc6216674][bookmark: _Ref6926526][bookmark: _Toc5889378][bookmark: _Toc6216671][bookmark: _Ref6915637]Line Breaks
In this image the Show/Hide button is toggled on to show the non-printing characters such as tab spaces, enters (paragraphs) and line breaks.
· Use Shift + Enter to create a line break within a paragraph. This will line up images and additional lines of text that fall under a specific step.
Example:
[image: ]
[bookmark: _Toc9848151]Page Breaks
Managing page breaks can be done in a way that saves you time as you edit and move around information. It is best NOT to use Ctrl + Enter to start a new page to avoid awkward page breaks. You should NOT need to press the Enter key until you have a new page.
Some templates include an automatic page break before certain heading (Page break before) such as Scenario and the Activity styles.
The Paragraph Pagination settings can be used to control where page breaks occur. These settings can be found on the Line and Page Break tab in the Paragraph dialog box.
1. Click the Paragraph Dialog Launcher icon (diagonal arrow) on the Home tab. [image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML9e7476.PNG]
1. Navigate to the Line and Page Break tab.
[image: ]
When you want to prevent a page break to occur between two paragraph (e.g. between a step and the image that illustrated the step), click the first of the two paragraphs and choose Keep with next

	[image: ]
	NOTE: this does not mean that all of the next paragraph will stay with the previous paragraph.



You can apply the Keep with next setting for a few paragraphs (steps) at a time. However, be careful that you do not leave this setting turned on as you will find that you could create a blank page as too much information has been set to keep together.
When you want a paragraph to prevent a page break in the middle of a paragraph, choose Keep lines together.
The Widow and Orphan control setting is on by default. This setting prevents a page break before the last line when there a only a few words on the last line. Word will take the second last line and put it with the “orphaned” words. You rarely need to turn this off.
[bookmark: _Toc9848152]Controlling Page Breaks in a Table
By default, a page break can occur within a row. 
When you want the content of a row to stay on the same page, uncheck the Allow row to break across pages checkbox on the Row tab of Table Properties. 
[image: ]

The Table Heading style has the Keep with Next is turned in the Paragraph dialog box on the Line and Page Breaks tab. This will keep the first row of a table on the same page as the second row in the table.
[image: ]

Repeat Table Headings 
When tables continue on another page you can select the header row or rows and turn on the Repeat as header row at top of each page checkbox 
1. Click in the heading row or select two rows if applicable.
Turn on the Repeat Header Rows button on the Layout tab.
 [image: ]

[bookmark: _Toc9848153]Special Tables 
There are two variations of tables that are used in a few of the templates. They are called the Note table and the Warning table. 
Note Tables
NOTE tables can be used to provide:
· additional information (e.g. something that happens downstream)
· information about an exception 
· an alternative method  
· a valuable tip
· To avoid accidentally changing the format, it is recommended that you copy these tables to wherever needed. To learn how to copy and paste a table, go to page 9. 
Be strategic when determining where to placing NOTE tables.  The learner needs to go through the “happy” path before learning all about the exceptions, troubleshooting tips. 
Avoid placing the box in the middle of set of steps that go together, e.g. a few steps that go with a screenshot.
If a NOTE table contains more than a few paragraphs or points, it might be better to create a new heading and section to detail the exception or troubleshooting tip. You can refer to the heading in the step by step instructions.
Examples of Note Tables
[image: ]

[image: ]
WARNING Tables
A WARNING table is a good way to bring the  learner’s attention of some information that can cause problems such as:
Critical clinical information
Critical information that the system requires
Include a brief rational of why the issue is important.
It is best to copy and paste additional NOTE boxes to maintain the formatting. . See page 15.
Examples of Warning Tables
[image: ]


	[image: ]
	WARNING: (multiple points)
· For only one point, use an inline note without bullets
· This example is for multiple warning points


[bookmark: _Ref8310684]
[bookmark: _Toc9848154]Using Table and Formatting
[bookmark: _Toc5889380][bookmark: _Toc6216676][bookmark: _Toc9848155]Insert a Table
1. To insert a table, click the Table drop-down arrow on the Insert ribbon.
Click and drag to select the number of rows and columns you want in the table. [image: ]
For information on preventing a page breaks in a row, see page 12.
[bookmark: _Toc9848156]Table, Tools and Layout tab
Your cursor must be in a table to be able to view this tab. Select Layout.
[image: ]
Click Properties for more options. [image: ]
Inserting Rows and Columns
Use these buttons found in the Rows & Columns section under Layout of the Table Tools tab to insert rows and columns.
[image: ]
Deleting Rows and Columns
Use the Delete drop-down arrow under the Rows & Columns group to delete a row, column, cell or the entire table.  
Your cursor must be in a specific row or column to Delete a row or column.
You can delete multiple rows or columns by selecting the rows or columns you want to delete.
[image: ]
[bookmark: _Toc9848157]Adjusting Row, Column, Cells & Table Properties
Click Click Properties for more options. [image: ]

Row Settings
Each row can be formatted by clicking in Row tab within Table Properties.
You can format the next or previous rows by using the button shown at the bottom.
Row settings include:
Row Size (height): Row height can be set to be At Least (no shorter than) the height entered or Exactly (no more or less than) the height entered. Be careful as the Exact setting can cut off text.
Turning off the Allow row to break across pages can add a blank space on the previous page.
[image: ]
See information on adding page break in row on page 12
Column Settings
The column width can be set to be exact.
Click Next or Previous column buttons to modify the column width.
[image: ]
TIP: This can be handy when you insert a column and your table “falls” off the page.
Cell Settings
	The vertical alignment can be applied to the selected table cell or cells.
	[image: ]


Table Settings
	A number of settings are available in this tab:
Size (table width)
Alignment
Text Wrapping (please keep setting at None)
	[image: ]



[bookmark: _Toc6216678][bookmark: _Toc9848158]Table Design
Some templates have a default Design applied to a new table. Designs are available on the Design tab. Cell Shading and Borders can also be set from the Table Properties window.
The CST Table design is the default design for many templates.

	Table Heading
	Table Heading
	Table Heading

	Table Text
	Table Text
	Table Text

	Table Text
	Table Text
	Table Text




	1. Click anywhere on the table.
1. Select Design tab under Table Tools.
1. Hover to make sure you have located the CST Table Design. Click to apply.
1. [bookmark: _GoBack]You can turn off the shading for the header row by deselecting Header Row check box on the Table Style Options.
	[image: ]   [image: ]
[image: ]



[bookmark: _Toc9848159]Customize Table
	Borders
	Applies a border (line) for borders above, between and below to a table, or selected cell(s).
Choose the style, colour and width of the border and then click the different buttons to apply the style to one or more line. You will need to re-apply the line if you want to change the style.
	[image: ]

	Shading
	Applies cell shading to a table or selected cell or cells. 
Shading can also be done on the Table Tools Design tab.
	[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML56c07aa.PNG]



[bookmark: _Toc6216679][bookmark: _Ref6908774][bookmark: _Ref6908791][bookmark: _Toc9848160]Table of Contents (TOC)
A Table of Contents (TOC) is a type of Reference in Word. By default, a Table of Contents will insert the text where Heading 1, Heading 2 and Heading 3 styles have been applied. In some templates there are Special Heading styles that are based on these heading styles. They will also get pulled into the Table of contents.
1. Prepare a page near the beginning of your document where you want to add the table of contents.
1. Enter a Heading, e.g. Table of Contents. If you do not want the table of contents title, do not apply a style based on Heading 1, Heading 2 and Heading 3 styles.

As we have seen, these heading styles have a Level number. The Level number controls the indentation of the different headings listed in the TOC.
1. Click the Table of Contents button on the References ribbon.
1. Choose the format for the table of contents.

[image: ]

A table of contents field is inserted with the headings.
	[image: ]
	NOTES: 
Table of Contents is not automatically updated. Right-click the TOC and select update table at the top left corner.
Only first three heading levels are displayed in the TOC.



[bookmark: _Toc6216680][bookmark: _Toc9848161]Update a Table of Contents
When you edit a document, you usually need to update the Table of Content field to ensure the headings and page numbers reflect changes. 
1. Right-click the Table of Contents field.
Choose Update Field.
[image: ]

Select Update entire table and click Ok.

 [image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML1480adf.PNG]
Review the TOC. Make sure that additional information is not included.
[bookmark: _Toc9848162]Troubleshoot Table of Content Problems
If you see text that is being pulled into the TOC that should not be there, formatting errors have been made. In this example there are two formatting errors that need to be fixed. 
· Some text in a section has a heading style applied (Introduction).
· There is also an image in another section has a heading style applied (Activity)
	[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTMLf92447.PNG]
1. Check the styles that have been applied to the text by selecting paragraphs and seeing which style is highlighted in the Styles Pane.
1. Apply the correct style for each of the paragraphs, including the blank paragraphs that need to be corrected.
Update the Tables of Contents to make sure all of the problems have been corrected (see page 7).
[image: ]

[bookmark: _Toc9848163]Section Breaks
A Word document may have section breaks, where in most larger templates (eg. Workbook template), have been pre-built into the styles. There are two main kinds of sections. Continuous pertains to part of a page or pages. Next Page includes an entire page or pages. 
1. To insert a section, click the Breaks drop-down button on the Page Layout ribbon.
[image: ]
1. Choose the type of section that you need.
[image: ]
[bookmark: _Toc9848164]Continuous Sections
Continuous section formatting includes column numbers (default is one column) and margins for a specific area. You should not need to modify the margins.
[bookmark: _Toc9848165]Next page Sections
Next Page Section formatting controls:
Page orientation (landscaping and portrait)
Paper size 
Headers and Footers. 
Some margin settings are applied to entire pages, e.g. Mirrored.
[bookmark: _Toc6216681][bookmark: _Ref8026618][bookmark: _Ref9591089][bookmark: _Toc9848166]Using Snagit to Capture screenshots
Getting good quality screenshots improve how well the learner can see the images and therefore learn the content. 
[bookmark: _Toc6216683][bookmark: _Ref9847944][bookmark: _Toc9848167]Prepare Your Screen
Before grabbing the screenshot:
Place the screen on a large monitor, rather than the laptop monitor. The large monitors have a much higher resolution.
When you want to take the screenshot of the whole window of the clinical application: 
Decrease the size of the window as much as possible
Adjusting the width of the columns
Collapse any unnecessary widget or category on the screen
Before & After Example of Preparing Your Screen
	[image: ]
	[image: ]



When you only need to capture part of the screen:
Only capture the part of the screen that you need to. 
If you need to crop the image, crop the image in Snagit
[bookmark: _Toc9848168][bookmark: _Toc6216684]Edit Image in Snagit
Perform screenshot adjustments (e.g. cropping) in Snagit not in Word document.
Perform all edits, such as adding numbers, boxes and call outs in Snagit and then copy-paste the whole image to the Word document.
[bookmark: _Toc9848169]Add Boxes to Identify Parts of a Screen
Use the shape drawing tools in Snagit to highlight the area you are showing.

[image: ]

	[image: ]
	NOTES: For older versions of Snagit:
1. Select Drawing Tools on the toolbar. 
1. Choose the red box. 
[image: ]


[bookmark: _Toc9848170][bookmark: _Toc6216685][bookmark: _Ref9591650]Add Letters or Numbers to a Screenshot 
Use the default red circle [image: ] (found in the Snagit Tools tab) for any areas that need to be call out sequentially. Don’t add the red circle with number in Word document. Then copy-paste the whole image to the Word document. Align the numbering on the screenshot with steps explained in contents. Use small lower case letters if necessary to convey sub-sets. 
1. Select Step from the More drop-down menu. 
1. The default shape is a red circle with numbers (1, 2, 3) in the middle. 
1. Toggle off the Shadow. This improves the crispness of the image.
[image: ]

	[image: ]
	NOTES: For older versions of Snagit:
1. Select the red round shape on the toolbar. 
[image: ]


[bookmark: _Toc6216686]Create Lower Case Letters for Sub Steps 
1. Click Step from the More drop-down menu.
1. Click the drop-down at the bottom of the screen to change the default numbers to lowercase letters; a, b, c. [image: ]
[image: C:\Users\CWILLI~1\AppData\Local\Temp\SNAGHTML5f712b.PNG]
	[image: ]
	NOTES: For older versions of Snagit:
1. Select the red round shape on the toolbar.
Double click on the number and change the value to a lowercase letter.
[image: ]



[bookmark: _Toc6216688][bookmark: _Toc9848171]Identify areas Areas of a Screenshot to Accompany a Legend: 
1. Choose Step from the More menu.
Change the values to A, B, C.
Select the square Shape. 
Resize the square if needed before you create the other letters, to make them all the same size.
[image: ] 
	[image: ]
	NOTES: For older versions of Snagit:
1. Select the square shape on the toolbar.
Change the fill to red and double click on the number to change to alphabets in capital form. 
Double click on the number to change to alphabets in capital form.
[image: ]


[bookmark: _Toc6216687][bookmark: _Toc9848172]Edit Step Values
1. To edit a value, right-click on a circle and choose Edit Value.
Enter the new value. 
Then type in the value. Remember the step letter or number should correspond with the written instruction.
Click the checkmark.
If you add more more numbers, Snagit will continue the sequence fron the value you entered.
[image: ]

[bookmark: _Toc9848173]Crop Images in Snagit
Capture just the part of the screen that you need to avoid needing to crop unnecessarily and improve the quality of your image. 
If you need to crop an image use Snagit, not in Word.
1. Select Crop from the More drop-down menu.
1. Drag any of the eight sizing handles [image: ] to reduce the screen area as needed. 
1. Click Crop button.

[image: ]

[bookmark: _Toc6216690][bookmark: _Toc9848174]Resize Images in Snagit
An image can be resized in Word as long as it is not more than 1500 pixels. Resize larger images in Snagit. Make sure you have resized the CST Cerner window to avoid really large images to improve quality (see page 39).
The image size can be determined at the bottom of the Snagit winow.
1. Click the box that displays the image size. A box opens.
Notice the lock by the Width and Height fields. The lock means that the new size with maintain the same ratio of height and width. Keep the Lock selected.
1. Enter either a new height or width.
1. Click Apply.
[image: ]
[bookmark: _Toc6216691]Reduce White Space in a Screenshot
Another way to improve a screenshot, and reduce the space in the document is to use the Cut Out tool. It is important to cut out blank parts of the screen.
1. Select Cut Out from the More drop-down menu.
Choose the Horizontal Cut Out option or the Vertical option.
Click and drag the area to cut out. When you let go of the mouse the selected area will be removed.

[image: ]

Last Updated: May 6, 2019		33 | 47
image10.png




image11.png




image12.png




image13.png
~ 13.0 Classroom Materials

13.1 Workbook ACTIVE (Classroom/Print Vi

13.2 Workbook DRAFT (In-Progress)

13.3 Workbook ARCHIVE
13.4 Key Learning Review ACTIVE (Classrc

- - Drag and drop to upload or browse for files
13.5 Key Learning Review DRAFT (In-Prog|

13.6 Key Learning Review ARCHIVE
v meamine Uploadflle

13.7 Login Sheet ACTIVE (Classroom/Print

File description = Comment
13.8 Login Sheet DRAFT (In-Progress)

13.9 Login Sheet ARCHIVE Upload

> 14.0 Library Comparisons

> Archive

¥ Download All | Lock All | Unlock All

e




image14.png
B S
B v e Foseiwow Retrewes  valigs reen | i
B_EIJ‘ E Ruler Q - (D) one Page

[ Gridiines = @3 Two pages

Full Screen Web  Outline  Draft Zoom  100%
=5 S

Document Views ‘Show Zoom

Navigation Pane 314

Open the Navigation Pane, which
allows you to navigate through the | gy 1 rea-
document by heading, by page, or aepice

by searching for text or objects. | seea





image15.png
U SETER e UHIE
Reading  Layout

Document Views

Navigation Pane
Show

Navigation
Search Document
88
4 Writing Learning Materials
Quick References
Grammar Tips
Create Learning Document
Upload Your Document
4 Learning Material Styles
What are Word Styles?
Styles Overview

Using Styles within your Template

General Formatting
‘Capturing screenshots

v x

2 -





image16.png
# Find -

2 Replace

« AaBbCcl e AaBbC o AaBt %

BodyText TBodyBul. 7BodyBul..  Change
g & ol <] G2 | setea-

Stytes Editing
Styles

Clear Al |
Stepihumber
stepzBulet
Stepaetier
step3Bulet
stepaBulet
BodyBulett
BodyBulet2
BodyBulets
Bullet Green
Scenario
Actvity
Heading 4
View Only
BodyText
Table Heading
TableText
Introduction
KeyLearnings.
ToCTite
Wiorkbook Tite:
Last_Updated
LegendLetter
proficency

B2p2aRBR1E=213=2=23=23=2=2-2-2=2=2.=2.=2.x2





image17.png
1. AaBb( e AaBbC a. AaBb( AaBbCcl
TSteplNu.. TStep2Bu.. TStepalet.. BodyText

o AaBt " AsBb m A¢ ¥ Aal
TBodyBul. TBuletGr.. Scenaro T Adity





image18.png
AaBE

oo 5




image19.png
o AaBt " AsBbt jm A¢ # Aalf AaBbCc ® AaBl AaBbCcl AaBbCel AaBbCcl % Aak -
TBodyBul.. TBUltGr.. Scenario  TAdivty Headingd TViewOnly TBodyled TableHea.. TTableText Introduci

1. AaBb( e AaBbC a. AaBb( AaBbCcl
TSteplNu.. TStep2Bu.. TStepalet.. BodyText

o AaBl B Az AaBI amoccr A aasoc (1 Az

Keyleami.. TOCTle TWorkbo.. LastUpda.. Tlegendl.. Proficiency 5





image20.png




image21.png
Paragraph .




image22.png




image23.png




image24.png




image25.png




image26.png
After setting up the-Multi-Patient-Task-List you can see the patients that are-under-your care Let's-
locatg a patient-and review one of theirtasks | i

1+Onthe Navigator window, ensure the box is checked beside Your Patient's-name §
2+Right-click on the task associated with Your Patent (.e. Holter Monitor)f

3-+Select Orderinfo to lear more about the-order.+/ e




image27.png




image28.png
cut

*»
42 copy
.

Dactn (vetimmee




image29.png
¥ ct
3 Cony

< Format painter





image30.png




image31.png
NOTES: (multiple points) This example is for muliple points
« Body Bullet 1

« Body Bullet 1





image32.png
Paste





image33.png
Home |sert  Pagelajout  References  Malings

cut

Arial BRI AR
Copy
“Format Painter

oard 5w





image34.png
Font





image35.png
Last_Updated




image36.png




image37.png
Paragraph 5




image38.png
Paragraph




image39.png
| 1 Don't add spage beteen paragraphs of the same stie

Preview





image40.png
BodyText
Step 1 Number




image41.png
&

= Words Grammars  Whe
The= definite- Use
article= The

are"




image42.png
i

= “.Key-Learning-Points=




image43.png
Paragraph




image44.png
ER




image45.png
Paste Options:

Restartat 1

Continue Numbering

Set Numbering Value...

Adjust List Indents





image46.png
d-Activity-1.3—Review-Patient-Tasks{

After setting-up-the Multi-Patient Task-List you-can see the-patients that-are-under-your care. Let's
locate-a-patient and review-one-of their tasks

1.-+On'the Navigator window, ensure-the-box is-checked beside- Your Patient's-name
2.-+Right-click on the task associated-withY our Patient.(i.e. Holter-Monitor){]

3. Select-Orderdnfo-to-learn-more-about-the-order. -+

Chatone O

R T Tk

o
‘The-Orderinformation window-opens ji




image47.png
1. Select the Postpartum section in the OB Recovery and Postpartum band.
2. Document the following data:

« Fundal Height Postpartum: (-1)

« Fundal Position: Midine

« Fundal Tone: Firm

« Bladder Distention: Absent

 Urinary Elimination: Voiding, no difficulties

« Bowel Elimination: Stooling, no difficulties

« Lochia Color: Rubra

« Lochia Amount: Light

Postpartum
Fundal Height Postpartum (1) umbilicus
Fundal Position Midline
Fundal Tone Firm

Bladder Distention labsent
Urinary Elimination Voiding, no...
Bowel Elimination Stooling, n...
Lochia Color

Lochia Amount

3. Sign ¥ your documentation.




image48.png
* Act

ity 1.2 — Customize View on Multi-Patient Task List

Mult-Patient Task List (MPTL) is the landing page. You can customize the MPTL by selecting the
appropriate Patient List and Time Frame to display.

1. Right click on Assigned Tasks in the grey information bar and select Customize Patient View.
The Task List Properties window appears.

2. Under the Patient List tab, complete the following:
a Click on the box beside Choose a Patient List

b. Click to check the View Assigned Tasks box if not checked already.

©. Click on the plus sign [/ besides All Locations to expand the location list.
d. Click on the box beside your assigned location from login sheet.
3. Click on Time Frames tab on top beside the Patient List tab and complete the following:
a Select Defined Time Frame.
b. Select Current
©. Select the 12 Hour Day Shift option frofm the list to the right.

4. Click OK button to complete sefting up your view in MPTL.




image49.png
1. Open Quick Orders.
2. Search forlmaging and Diagnostics.

3. Expand the NM tab.

o
18 14 R0 P WM Trescind
) 1o e 50 et

4. Click the PowerPlan (module) appropriate for your patient. Forthis example, NM CARD
Myocardial Perfusion MPI/MIBI Pharmaceutical (Module)B.

5. Click the Orders for Signature icon (Green Mailbox).

Quck ntes 2|+

et





image50.png
Paragraph.




image51.png
Paragraph

Indents and Spacing | Line and age Sreaks.

[CPage break before:




image52.png
- f—

Options
{liow ro to break across pages!
[ Repeat as header row at the top of each page





image53.png
Repeat
Header Rows




image54.png
NOTE: Only choose locations for units you are working on. If you choose an entire hospital or
too many locations, the system might not be able process all the tasks in the MPTL and you

will see too much information. Altemnatively, you can set up several separate location-based
lists.





image55.png
. NOTES: (multiple points) This example is for multiple points
o BodyBullet1

« BodyBullet!

NOTE: (single note) use full sentences and punctuation. For only one point, use an inline note
without bullets





image56.png
WARNING: When collecting multiple fluid samples at the same time, mark
each sample as collected at least 2 minutes apart from any other fluid samples. (Fiuid
does not include CSF or urine).





image57.png
Insert | Pagelayout  References

| B O

32 Table
I o o
I o
0000000000
0000000000
0000000000

s« 000000000
0000000000
0000000000

ot ([ InsertTabie.
0o 4 prawTable
fes| &, | Conyert Text to Table

[ Excel Spreadisneet

@ QuickTables >





image58.png




image59.png
=2

Properties




image60.png
¥ B

Delete | Insert Insert Insert Insert
‘ ~ " Above Below Left Right

Rows & Columns &





image61.png
EEE]

Insert Insert
Above _Below

Delete Cells
Delete Columns

Delete Rows

Bk %

Delete Table




image62.png
] Specify height: |0 cm. [5] Row heigntis: [at least =]

Options
[¥] Allow row to break across pages
[] Repeat as header row at the top of each page

e




image63.png
[ e T o I [av7en -

Column 2:
Size

/] preferred width: [8.25m [+ measurein: [centmeters [+ ]





image64.png
| Table | Row | cowmn |[cel ]| attex |

Size

7] Preferred width: [8.25cm [+ measure in: |centimeters [~]

Vertical alignment

Ol B





image65.png
[ atTex |

referred width: |0 cm %] weasure in: [centimeters [~

Alignment

Indent from left:





image66.png
Design | Layout





image67.png




image68.png
HeaderRow  [7] First Column

Total Row Last Column
Banded Rows

Table Style Options.

Banded Columns





image69.png




image70.png
{Shading}
[

age Border.

Cdor
stde: [ clear

Borders
Fil
Patterns.





image71.png
Home  Insert  Pagelayout | References | Mailing

G2y
i, ST B

insert insert
Footnote Citation ~

Show Notes

‘Automatic Table 2

Table of Contents

Heading 1
Hosang 2.

Manual Table

Table of Contents

‘Type chapter ttle (level 1).
ypechapor o pove 2).

Ty chpier o e 3)

Tvoe chaoter ttle flevel 11.

® More Tobe f Contents rom Office.com ,
nsert Table of onterts,
Bemore Tabl of Contents

Ba. Sove Seletion to Tabl o Contents Galr.





image72.png
Writing-for-Printed-Learnjng-Materials
«+ GeneralRules

- Grammar-Tips
(@ Paste Options:

= Creating-your-learning ¢ - 30
« - Uploading-yourdocume___— - 4q
55 Howtouse sylswiti| oo | = 51
=+ Formattin Eerels £ 59

9 Toggle Field Codes.

«~ Capturing screenshots. - 69
Prepare-Your Screen Parsgraph > 61
Using-Snagit Bulets I £ ]

*= LeamingMaterial Style, = wumbeing | » - 139

Working-in-Word ... LA svies

Formatting Text > 14q




image73.png
Update Table of Contents

‘Word is updating the table of contents. Select ne of
the folloning optons:
(© Update page numbers only

© pdate enie tabie]

(oot (mccie]





image74.png
® TABLE OF CONTENTS

Cardiology Technician: Ambulatory
+ TABLE OF CONTENTS ...

- SELF.GUIDED PRACTICE WORKBOOK.
+USING TRAN DOWAN. S

[Vou i b using the i comain to compee acivis n s workok. 1 has been
desgned o mic th v Comer Cinical niomaion Syt (1) 1 dosey &

- s
N e

“Aciiviy 1.1~ Set up your view of the Mul-Patient Task List





image75.png
T T Y
i i e it B G

i e e

E——— (R —

s G A S

View Only
BodyText
BodyBulett
BodyBulet2
BodyBulets
Stepihumber
stepzBulet
Stepaetier

5125 18

N R -]




image76.png
B Fome sert |

Page Layout | References  Mailings  Rey

onts ~
Themes

- [O]effeats -

Themes

anolors' @

G E

Margins Orientation  Size Columns

Page Setup

= Breaks -

£ Line Numbers -
5 Hyphenation

Gl





image77.png
Page
Mark the point at which one page ends
and the next page begins.

Column.
Indicate that the text following the column
break will begin n the next column.

Text Wrapping
Separate text around objects on web.
pages, such as caption text from body text.

Next Page
Insert a section break and start the new
section on the next page.

Inserta section break and start the new
section on the same page.

Even Page
Insert a section break and start the new
section on the next even-numbered page.

Odd Page
Insert a section break and start the new

\;Eﬁ section on the next odd-numbered page.




image78.png
e i 6355 i i S {1

N ® -
e E) | v @
W L * |
Py v - - 8[vve|mi-
s stoeavncrnr g o a -
e — . CIENE
s, stv g vve o -





image79.png
B) PowerChart Organizerfor TestUse, GeneraMedicine-Physican, MD [ololEs
Tesk Edit View Patient Chart Links Noffications Nvigaion Help

MyBiperience  Patient st Tracking Shell |

=1Message Centre . Patient Overview

@ CoreConnect @ PHSAPACS @ VCH and PHC PACS @MUSE @ FormFsst Wt |_| { flExt _ Communicste - i Discem Reporting Portl

- I -

Patient Overview D Fullscreen (EIPrint <> 12 minut

Ambulstory Organizer @pPatient Health Educstion Materiss |- | &, |”

ARIARIR & 0% oed
Patient Overview 2|+
List: LGH Emergency Department (19) v ‘ Add Patient. ‘ Establish Relationships ‘ patient search: Q
Fatent Iformtion Location Tiness Sevriy os. edes e
CSTSITTHREEASMITH, SITTWO. LGHED B ©ee o - =
61y F DOB:May1,1956 ACWR o
CSTTEST, MINA LGH MIU B vvvy o -
2y F DOB: Dec12, 1985 Mo11-01
*CSTPRODREG, EDTESTLABEL LGHED - F ¢ee o -
27y M DOB: May 10, 1990 -
MILLER-LEARN, ADAM LGH ED Hold - |] vve o -
59y= M DOB:Jans6, 1959 ACWR
CCSTSNLION, STBRAVEHEART LGHED - 6006 o -
3By= M DOB: Aug 10, 1979 -
CSTSNCPOE, STTESTONE LGH ED Hold - 60060 o -
24y= M DOB: Aug1, 1093 -
CSTSNTEST, STWORKFLOW LGH ED Hold - 0606 - -
17y= M DOB:Aug1, 2000 -
*CSTPRODREG, CMEDVERIFIED. LGHED = ee0 - -
48y= F DOB: Nov1,1969 ACWR A
CSTSNAPPLE, STPINE LGH ED - vve o -
26y= M DOB:Sep17, 1991 - a

PRODBC TESTMDGENMED Wednesday, 21-February-2018 13:48 PST





image80.png
Be 60 Juupe Shn Paw Yo U ‘Snage Eduor sonc @ - 0O X
A0 R .o

=y @ comee R od © coorne IEEETD

B





image81.png
Sl=mo s Snagit Editor - [Mar 14, 20:

_ Tools | Image Share Library
R7r 20 Houtine ~

& Fill

o \[Be & & e

Drawing Tools Styles

11:19:18 AM]





image82.png
Be [t Iege Ban Sue Yow bep

= oy @ copure





image83.png
Snagit Editor - [Apr 10, 2019 3:15:25 PM] 5

Library

L outline O % Q‘ It

&~ Restart | Copy & Tag Share
A Effects * Sequence Al ™ & v





image84.png
Be 60 Juupe Bhn Paw Yo U Smagh Ger' wr-® - 0 Xx
Naemheap[]N~
o T ot e S s s - 7 © = |

= oy @ copure

L yg—— v siyes +





image85.png




image86.png
e Edt Image Efects Shae View Help ‘Snagt Editor

= ubrary @ Coplure

NaehLals, wA

5 CrcComprs B ConclLenderOrgoncer . Pt it Mt Ptert ook

@ CoreCornec @PHSAPACS @VCH

4t 9o mMescaion dmintation & PM Converation 1) Mol Record Resvest + Add - B Document 815,

AnjaBaaiwx - 00q|

L — e T
B BA GLOERT-AEARN, JONIFER  boveiosucsn
s 7 tosm
Sy
2601 FORDLEARN, HARRY e
o o s
e

st o, 40
Busnes (604)986.5853

Robertson,Mary L, WD
Busnes (6041856017

Quick Styles

Theme: sosc

®©0eo
> o0

e
>0 o0

Tool Properties





image9.png




image87.png
S == s

Fle || Toos | Image Share Library
XM e Soure- £ % @
1 1 o . il - E:. Tag Share

Drawing Tools Styles

f Restart  Copy
‘ O\NCd oS N fificts * Sequence Al 1B





image88.png
Please selectthe facilly where you wart ta view persan
aliases

Facly:





image89.png




image90.png
23 Snagt Edtor seninv @@

oy @ Copture

“h @ co s [T

) N imreniems 4 it

iy _
g roR A Ry reder W





image91.png
Ty ——mr——

“rs+7 12z 0ann

o el L AR P o0 R G s o
ER— w0
4 meeawe o
- o +
o e " m o ® .
G R +
3 hea i

© Recent

* g





image92.png
=
=~

w00

it i i 2





image93.png
“ CLINICAL = SYSTEMS
TRANSFORMATION

Our path o smarter seamless care




image94.png
TRANSFORMATIONAL
LEARNING




